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1. FORWARD 

 
The module D10 is assigned content wise to Industrial field bus systems. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Learning goal: 
 
In this module, the reader should learn how the PROFIBUS DP is taken into operation with a SIMATIC 
S7-300 with the communication processor CP 342-5DP as a master and as a slave.  The module 
shows the principle procedure by means of a short example.  
 
Requirements: 
 
For the successful use of this module, the following knowledge is assumed: 
 
• Knowledge in the use of Windows 95/98/2000/ME/NT4.0 
• Basics of PLC- Programming with STEP 7 (e.g. Module A3 - ‘Startup’  
 PLC programming with STEP 7) 
• Basics of the PROFIBUS DP (e.g. Appendix IV – Basics of  

field bus systems with SIMATIC S7-300) 

Basics of 
STEP 7- Programming 
2 - 3 days     A modules 

Industrial field bus 
systems 

2- 3 days D modules 

Additional functions of 
STEP 7- Programming 
2- 3 days    B modules 

Process 
visualization 

2- 3 days F modules 

Sequencer 
Programming 

2- 3 days C modules 

IT- Communication 
with SIMATIC S7 

1- 2 days E modules 
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Required hardware and software  
 
1 PC, Operating system Windows 95/98/2000/ME/NT4.0 with 

- Minimal: 133MHz and 64MB RAM, approx. 65 MB free hard disk space 
- Optimal: 500MHz and 128MB RAM, approx. 65 MB free hard disk space 

2 Software STEP 7 V 5.x with option NCM S7 PROFIBUS 
3 MPI- Interface for the PC (e.g. PC- Adapter) 
4     PLC SIMATIC S7-300 with the CP 342-5DP  
 Example configuration: 

- Power supply: PS 307 2A 
- CPU: CPU 314IFM 
- PROFIBUS- Communication processor: CP 342-5DP 

5     PLC SIMATIC S7-300 with the CP 342-5DP  
 Example configuration: 

- Network: PS 307 2A 
- CPU: CPU 314IFM 
- PROFIBUS- Communication processor: CP 342-5DP 

6 PROFIBUS cable with 2 PROFIBUS slots  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1 PC 

 
2 STEP 7 

3 PC Adapter 

 
4 SIMATIC S7-300 with  

CP 342-5DP 

 
5 SIMATIC S7-300 with  

CP 342-5DP 

6 PROFIBUS cable 
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2. NOTES FOR THE OPERATION OF THE CP 342-5DP 

 
The PROFIBUS communication processor CP 342-5DP makes it possible to attach to itself the 
SIMATIC S7-300 by the PROFIBUS with the protocol profile distributed I/O (DP). 
 

The parameterizing of the PROFIBUS parameters for the PLC, such as the configuration of the 

PROFIBUS network, takes place with the software STEP 7. The requirement is the CP342-5DP and 

additionally the software “NCM S7 PROFIBUS “ (Contained already in STEP 7 V5.x!), so that the user 

has a uniform configuration tool for centralized and distributed configuration.  

 
For the SIMATIC S7-300 with the CP342-5 as a Combimaster, the following protocol profiles are at your 
disposal: 
• DP- Interface as master or slave according to EN 50170. PROFIBUS-DP (Distributed I/O) is the 
 protocol profile for the connection of the distributed I/O/field equipment with a quick reaction 
 time. 
• SEND/RECEIVE- Interface (AG/AG) according to the SDA-Service (Layer 2 of the  
 PROFIBUS). SEND/RECEIVE (FDL- Interface) offers functions with which the  
 communication between SIMATIC S5 and S7 are under one another and they can simply and 
 quickly be realized to the PC. 
• S7-Functions. These offer optimal communication in the SIMATIC S7/M7/PC-connection. 
 
On the part of the user program, the transmission of the data range for the DP and FDL communication 
is activated through programmed FC-Block calls and monitoring of effective execution monitored. 
The block calls for the important communication FC blocks are found in the library  
“SIMATIC_NET_CP“. In order to use these functions, the function must be copied into the project.  
 
Note:  Here 2 SIMATIC S7-300 with theCP 342-5DP are appointed to the PROFIBUS as a  
  master and as a slave. 
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3. COMMISSIONING THE PROFIBUS ( MASTER CP 342-5DP / SLAVE CP 342-5DP) 

In the following example, the commissioning of a mono master system with the SIMATIC S7-300 with 

CP 342-5DP as a master and an additional SIMATIC S7-300 with a CP 342-5DP as a slave is 

described. 

For the testing of the configuration, a program will be written in which an input (SET) can be preset in 

each PLC. This byte is transferred over the PROFIBUS to the other PLC and can then be displayed 

over a display byte (DISPLAY). 

 

Assignment list Master- CPU: 
IB 124 SET   Input byte 
IB 40 Comm_IB1  Input communication Byte1 
QB 124 DISPLAY  Display byte 
QB 40 Comm_QB1  Output communication Byte1 
 
Assignment list Slave- CPU: 
IB 124 SET   Input byte 
IB 40 Comm_IB1  Input communication Byte1 
QB 124 DISPLAY  Display byte 
QB 40 Comm_QB1  Output communication Byte1 
 
For the connection of the two CPU342-5DP, whereby one is set as a master and the other as a slave, 

the following steps must be followed. 

 

 

1.  The central tool in STEP 7 is the SIMATIC Manager, which is opened here with a double click       

( → SIMATIC Manager). 
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2.  STEP 7- Programs are administered in projects . Such a project will be created ( → File → New). 
 

  
 
 
3.  Give the Name CP342_CP342 to the project ( → CP342_CP342 → OK). 
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4. Highlight your project and insert a PROFIBUS Subnet (→ CP342_CP342 → Insert → Subnet → 

PROFIBUS). 
 

 
 
5. Then insert a SIMATIC 300-Station (→ Insert → Station → SIMATIC 300-Station). 
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6.  Change the name of the station to Slave  (→ Slave). 
 

  
 
7.  Open the configuration tool for the Hardware  with a double click (→ Hardware). 
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8.  Open the hardware catalog with a click on the symbol   (→ ). 
There you will see the directories are divided into the following: 
- PROFIBUS-DP, SIMATIC 300, SIMATIC 400 and SIMATIC PC Based Control, 
all module racks, modules and interface modules for the configuration of your hardware configuration 
are made available. 
Insert a Rail with a double click( → SIMATIC 300 → RACK-300 → Rail). 

 

  
 

After the insert, a configurations table for the configuration of the Rack 0 appears automatically. 
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9. Now all modules can be chosen out of the hardware catalog and inserted into the configuration 

table and are also inserted into your rack.  To insert, you must click on the name of the respective 
module, hold the mouse button and Drag & Drop the module into a line of the configurations table.  
We will begin with the power supply PS 307 2A (→ SIMATIC 300 →PS-300 → PS 307 2A).    

 

  
 
Note: If your hardware differs from what is shown above, then you must select the appropriate       
modules from the catalog and insert them into the rack.  The part numbers of the individual modules, 
which are found on the components, are indicated in the footer of the catalog.
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10. In the next step, we drop the CPU 314IFM into the second card location.  This allows for the part 

number and version of the CPU to be read off (→ SIMATIC 300 →  CPU-300 → CPU 314IFM → 
6ES7 314-5AE03-0AB0 → V1.1 ). 

 

  
 
Note:  The addresses of the integrated in-/outputs by the CPU314IFM can be read into the  
  hardware configuration.  However, they are directly on the CPU. 
  They are the digital inputs IB124 and IB125 such as I126.0-I126.3.  
  The digital outputs have the addresses QB124 and QB125. 
  The analog inputs are found on PIW128, PIW130, PIW132 and PIW134. 
  The analog output is found on PQW128. 
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11. Then we drag the communication processor for the PROFIBUS CP 342-5DP onto the 
 fourth slot. Now the order number and version of the model can be read off the front (→ 
 SIMATIC 300 →  CP-300 → PROFIBUS →  CP 342-5DP → 6GK7 342-5DA01-0XE0 → 
 Product Version 2).  

 
 

   
 
 
 Note: Slot number 3 is reserved for interface modules and remains empty. The order number of 
 the module is displayed in the footer of the catalog. 
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12. By the entering of the communication processor, the following window appears, in which you   

assign a PROFIBUS address to the CPU 342-5DP and must already choose the first PROFIBUS 
net. When you want to alter the parameter of the PROFIBUS net, you must highlight it and then 
click on Properties (→ 2 → PROFIBUS(1)). 

 

  
 
13. Now you can choose the Highest PROFIBUS Address (here → 126), the Transmission Rate 

(here → 1,5 Mbit/s) and the Profile (here → DP). (→ OK). 
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14. Now the addresses of the communication processor in the I/O address space of the CPU are 

noted (Here: PI 256...271 / PQ 256..271).  Choose the properties of the communication process 
through a double click on the ‘CP 342-5DP’ ( → CP 342-5). 

 

  
 
15. Set the Operation Mode  to DP slave and accept with OK ( → Operation Mode → DP slave → 

OK). 
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16. The configuration table is saved and compiled now with a click on . Then the hardware 

configuration is closed with a click on x   ( →  → x ). 
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17. Now in SIMATIC Manager enter an additional SIMATIC 300-Station (→  SIMATIC Manager → 

Insert → Station → SIMATIC 300-Station). 
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18.  Change the name of the station to Master (→ Master). 
 

 
 
19.  Open the configuration tool for the Hardware  with a double click (→ Hardware). 
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20. Open the hardware catalog with a click on the symbol   (→ ). 
There you will see the directories are divided into the following: 
- PROFIBUS-DP, SIMATIC 300, SIMATIC 400 and SIMATIC PC Based Control, 
all module racks, modules and interface modules for the configuration of your hardware                                                                                             
configuration are made available. 

      Insert a Rail with a double click( → SIMATIC 300 → RACK-300 → Rail). 
 

  
 
 After the insert, a configurations table for the configuration of the Rack 0 appears automatically. 
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21.  Now all modules can be chosen out of the hardware catalog and inserted into the configuration 

table and are also inserted into your rack.  To insert, you must click on the name of the respective 
module, hold the mouse button and Drag & Drop the module into a line of the configurations table.  
We will begin with the power supply PS 307 2A (→ SIMATIC 300 →PS-300 → PS 307 2A).  

 

  
 
Note: If your hardware differs from what is shown above, then you must select the appropriate       
modules from the catalog and insert them into the rack.  The part numbers of the individual modules, 
which are found on the components, are indicated in the footer of the catalog.
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22. In the next step, we drop the CPU 314IFM into the second slot.  This allows for the part number 

and version of the CPU to be read off the front (→ SIMATIC 300 →  CPU-300 → CPU 314IFM → 
6ES7 314-5AE03-0AB0 → V1.1 ). 

 

  
 
 
Note:  The addresses of the integrated in-/outputs by the CPU314IFM can be read into the  
  hardware configuration.  However, they are directly on the CPU. 
  They are the digital inputs IB124 and IB125 such as I126.0-I126.3.  
  The digital outputs have the addresses QB124 and QB125. 
  The analog inputs are found on PIW128, PIW130, PIW132 and PIW134. 
  The analog output is found on PQW128. 
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23. Then we drag the communication processor for the PROFIBUS CP 342-5DP onto the fourth slot. 

Now the order number and version of the model can be read off the front (→ SIMATIC 300 →  CP-
300 → PROFIBUS →  CP 342-5DP → 6GK7 342-5DA01-0XE0 → Product Version 2).  

 
 
 

 
 
 
 
Note: Slot number 3 is reserved for interface modules and remains empty. The order number of the 
module is displayed in the footer of the catalog.
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24. By the entering of the communication processor, the following window appears, in which you   

assign a PROFIBUS address to the CPU 342-5DP and must already choose the first PROFIBUS 
net (→ 4 → PROFIBUS(1)). 
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25. Now the addresses of the communication processor in the I/O address space of the CPU are 

noted (Here: PI 256...271 / PQ 256..271).  Choose the properties of the communication process 
through a double click on the ‘CP 342-5DP’ ( → CP 342-5). 

 

 
 
26. Set the Operation Mode  to DP master and accept with OK ( → Operation Mode → DP master 

→ OK). 
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27. Then a bar chart for the Master system is shown to the right of the CPU342-5DP, in which you 

can arrange the PROFIBUS slaves. This happens by clicking the desired module 
(Here the S7 300 CPU342-5DP as Configured Stations) from the hardware catalog in path 

 PROFIBUS-DP.  By Drag & Drop click with the mouse, it can be dropped into the master system 
(→ PROFIBUS DP → Configured Stations → S7-300 CP342-5DP → 6GK7 342-5DA0x-0XE0 ). 
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28. By the entering of the SIMATIC S7-300 with CPU342-5DP as a slave, the following window is 

displayed in which you must Connect the already configured slave (PROFIBUS- Address 2) to the 
other SIMATIC S7-300 with CPU 342-5DP as master ( → Connect). 

 

  
 
29. After the connection, the CPU315-2DP is entered as an active connection. This connection is then 

accepted with OK ( → OK ). 
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30. In slot 0 of the connected slave, a Universal module must be entered, in order to arrange the 

communication range between master and slave (→ PROFIBUS DP → Configured Stations → S7-
300 CP342-5DP → 6GK7 342-5DA0x-0XE0 → Universal module). 

 

 
 
31. Highlight Universal module and double click it ( → Universal module ). 
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32. Then the communication range is arranged.  Choose Out-input with a byte Output and a byte 

Input (→ Out-in → OK). 
 

 
 
 
Note:  The indicated addresses are the in-/output addresses within the communication processor.  In 
the program of the CPU, one cannot directly access these addresses.  First the in-/output address 
ranges must be transferred over FC blocks in address ranges of the CPU. 
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33. The configuration table is saved and compiled now with a click on . Then the hardware 

configuration is closed with a click on x   ( →  → x ).  

 

  

 



         Automation– and Drive Technology- SCE 
   

 
T I A  Training document Page 31 of 38              Module D10 

Last revision: 02/2002                                                                                      PROFIBUS-DP with Master CP 342-5DP / Slave CP 342-5DP 

Forward                                     Notes                                     Commission 

 
34.  From the SIMATIC Manager, open the block OB1 for the slave with a double click ( → OB1). 
 

  
 
 
35.  Optional:  Enter the properties of the OB1 for documentation and accept with OK ( →OK). 
 

  
 

 



         Automation– and Drive Technology- SCE 
   

 
T I A  Training document Page 32 of 38              Module D10 

Last revision: 02/2002                                                                                      PROFIBUS-DP with Master CP 342-5DP / Slave CP 342-5DP 

Forward                                     Notes                                     Commission 

 
The transmission of the data range for the in- and outputs of the PROFIBUS DP slaves is activated 
through the programmed FC block calls of the user program. These FCs also monitor the effective 
execution. 
The block calls for the important communication FC blocks are found in the library  
“SIMATIC_NET_CP“. In order to use these functions, the functions must be copied into the project.  
 
The FC block DP-SEND transfers data from the user program in the CPU to the PROFIBUS- CP.  For 
the operation type of the PROFIBUS– CP, the DP-SEND has the following importance: 
• For the application in DP-Master 

The block assigns the data of the indicated DP output range to the PROFIBUS-CP for the output 
module by the distributed I/O.  

• For the application in DP-Slave 
The block assigns the data of the indicated DP data range of the CPU in the send buffer of the 
PROFIBUS-CP for transmission to the DP-Master. 
By the call of the FC block DP-SEND, the following parameters must be entered: 

 

Name Type Range of values Comment 

CPLADDR WORD  Module-start address (The configuration table can be 
extracted in STEP 7). 

SEND ANY  Indication of the address and length of DP-Send range 
(the address can refer to the I/O-Ranges, bit memory 
address areas and data block areas). 

DONE BOOL 0: - 
1: new data 

Displays, if the job was handled error free. 

ERROR BOOL 0: - 
1: Error 

Error display 

STATUS WORD  Status display 
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The FC-Block DP-RECV receives data over the PROFIBUS DP. For the operation type of the 
PROFIBUS –CP, the DP-SEND has the following importance: 
• For the application in DP- Master 

The block accepts process data of the distributed I/O as status information in the indicated DP input 
range. 

• For the application in DP- Slave 
The block accepts the transferred DP data of the DP- Master from the receive buffer of the 
PROFIBUS -CP in the indicated DP data range of the CPU. 
By the call of the FC block DP-RECV, the following parameters must be entered: 

 

Name Type Range of values Comment 

CPLADDR WORD  Module-start address (The configuration table 
can be extracted in STEP 7). 

RECV ANY  Indication of the address and length of DP-
receive range (the address can refer to the 
I/O-Ranges, bit memory address areas and 
data block areas). 

NDR BOOL 0: - 
1: new data accepted 

The state parameter displays, if new data was 
accepted. 

ERROR BOOL 0: - 
1: Error 

Error display 

STATUS WORD  Status display 

DPSTATUS BYTE  DP-Status display  
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36. With LAD, STL, FBD: Program blocks, you now have an editor which gives you the possibility to 

generate your STEP 7- Program.  Here the organization block OB1 was already opened with the 
first network.  In order to generate your first logical operation, you must highlight the first network.  
Now you can write your first STEP 7- Program.  Several programs can usually be divided into 

networks.  Open a new network by clicking on the network symbol  . 
 

Here the received data as inputs from the DP master are read into network 1 with the block DP_RECV.  
You can insert this block into your network from the Libraries of blocks in the catalog ( → Libraries → 
SIMATIC_NET_CP → CP 300 → FC2 DP_RECV). 
 
In Network 3, the sent data is written as outputs to the master with the block DP_SEND. You can 
insert this block into your network from the Libraries of blocks in the catalog ( → Libraries → 
SIMATIC_NET_CP → CP 300 → FC1 DP_SEND). 
 

Now save the OB1 block  ( → ).  
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Note:   Here the master is connected with 1 byte input data and 1 byte output data over a CP342-5DP 
on slot 5 (Module start address decimal: 256/Hexadecimal 100).  The input data should be in input byte 
IB40.  The data should be written into the master from output byte QB40. 
 
 
 
37. The STEP 7- Program must now be downloaded into the PLC.  In our case, this can be done from 

the SIMATIC Manager.  There, highlight the folder Slave  and then click on download .  The 
mode switch must be on STOP and the program equipment must be connected with the MPI-

Interface of the CPU! (→ SIMATIC Manager → Slave → ) 
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38.  From the SIMATIC Manager, open the block OB1 for the master with a double click ( → OB1). 
 

  
 
39.  Optional:  Enter the properties of the OB1 for documentation and accept with OK ( →OK). 
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40. With LAD, STL, FBD: Program blocks, you now have an editor which gives you the possibility to 

generate your STEP 7- Program.  Here the organization block OB1 was already opened with the 
first network.  In order to generate your first logical operation, you must highlight the first network.  
Now you can write your first STEP 7- Program.  Several programs can usually be divided into 

networks.  Open a new network by clicking on the network symbol  . 
 

Here the inputs of the DP slaves are read into network 1 with the block DP_RECV.  You can insert this 
block into your network from the Libraries of blocks in the catalog ( → Libraries → SIMATIC_NET_CP 
→ CP 300 → FC2 DP_RECV). 
 
In Network 3, the outputs of the DP slaves are written with the block DP_SEND. You can insert this 
block into your network from the Libraries of blocks in the catalog ( → Libraries → SIMATIC_NET_CP 
→ CP 300 → FC1 DP_SEND). 
 

Now save the OB1 block  ( → ). 
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Note:    Here the other S7-300 with CP342-5DP as a slave is copied onto slot 5 (Module start  
  address decimal: 256/Hexadecimal 100).  The input data should be in input byte IB40.   
  The data should be sent to the slave from output byte QB40.  
 

It is important that all data in the defined DP slaves hardware configuration is integrated 
 with block DP_RECV and DP_SEND, whereby all DP slaves are combined in a 
 DP_RECV and DP_SEND. 

The addresses of several modules can be extracted from the hardware configuration. 
 
41. The STEP 7- Program must now be downloaded into the PLC.  In our case, this is done from the 

SIMATIC Manager. The you must highlight the folder Master and click on download . The 
mode switch of the CPU must be on STOP and the program equipment must be connected with 

the MPI-Interface of the CPU! (→ SIMATIC Manager → Master → ) 
 

  
 
42.  Through the switching of the mode switch to RUN, the program is started. It is best to turn the 

slave on first before the master. 
 
 

 

 


